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End User License Agreement (EULA)

Digital Synsations (henceforth ‘the Product’) is licensed to you as the 

end user.  Please read this Agreement carefully.

You cannot transfer ownership of these Sounds and Software they 

contain. You cannot re-sell or copy the Product.

LICENSE AND PROTECTION 

1. License Grant

UVI grants to you, subject to the following terms and conditions, a 

non-exclusive, non-transferable right to use each authorized copy of 

the Product. 

The product is the property of UVI and is licensed to you only for 

use as part of a musical performance, live or recorded. This license 

expressly forbids resale or other distribution of the sounds and 

software included in the Product or their derivatives, either as they 

exist on disc, reformatted for use in another digital sampler, or mixed, 

combined, filtered, resynthesized or otherwise edited, for use as 

sounds, multi-sounds, samples, multi-samples, wavetables, programs 

or patches in a sampler, microchip or any hardware or software 

sample playback device. 

You cannot sell the Product content or give it away for use by others 

in their sampling or sample playback devices. In the event UVI 

terminates this agreement due to your breach, you agree to return 

the original and all other copies of the software and documentation 

to UVI.

UVI reserves all rights not expressly granted to herein. 

2. Protection of Software

You agree to take all reasonable steps to protect the product and any 

accompanying documentation from unauthorized copying or use. You 

agree not to modify the product to circumvent any method or means 

adopted or implemented by UVI to protect against or discourage the 

unlicensed use of copying of the Product. 

3. Ownership

As between you and UVI, ownership of, and title to, the enclosed 

digitally recorded sounds (including any copies) are held by UVI. 

Copies are provided to you only to enable you to exercise your rights 

under the license. 

4. Term

This agreement is effective from the date you open this package, 

and will remain in full force until termination. This agreement 

will terminate if you break any of the terms or conditions of this 

agreement. Upon termination you agree to destroy and return to UVI 

all copies of this product and accompanying documentation. 

5. Restrictions

Except as expressly authorized in this agreement, you may not rent, 

sell, lease, sub-license, distribute, transfer, copy, reproduce, display, 

modify or time share the enclosed product or documentation. 

 

©2014 UVI. All rights reserved.
All trademarks are the property of their respective owners.

Do not use this product until the following license agreement is understood and accepted.
By using this product, or allowing anyone else to do so, you are accepting this agreement.
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Introduction

Digital Synsations

In the late 80’s and early 90’s the synthesizer landscape 

began to change. A new breed of keyboards began 

appearing in shops, records and on stage; matte 

black behemoths eschewing the familiar knob arrays 

for uniform clusters of discrete buttons and glowing 

green LCD screens. They signaled more than a shift in 

interaction with our musical counterparts‚ they ushered 

in the era of the digital synth.

To those willing to forgo the immediacy and ease-of-

editing of the analog synth world, these keyboards 

offered amazing features such as massive polyphony, 

extensive on-board sequencer and pattern memory, 

removable storage and digital effects. In addition to 

the immediate benefits of digital processing some 

of these keyboards also dawned innovative hybrid 

synthesis techniques, combining sample playback with 

classic methods allowing synthesists and musicians the 

opportunity to explore new sonic territory.
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System Requirements

Compatibility
Audio Units, VST, MAS, AAX, RTAS or standalone

UVI Workstation 2.5.2 or higher

Minimum System Requirements
  Intel CPU 

  4 GB of RAM (8 GB+ recommended) 

  10 GB of disk space

  Mac OS X 10.7 or higher

  iLok account (free, dongle not required)

Compatibility 
VST, AAX, RTAS or standalone

UVI Workstation 2.5.2 or higher

Minimum System Requirements
  Core Duo or faster

  4 GB of RAM (8 GB+ recommended)

  10 GB of disk space

  Windows 7 or higher

  iLok account (free, dongle not required)

Authorize the Way You Want
Your license allows 3 concurrent authorizations on any combination of computers and iLok dongles.  

License management is a simple drag-and-drop process done through iLok License Manager.

Visit ilok.com/  to download iLok License Manager and create your free account.
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  You must have an account on uvi.net/  and ilok.com/  prior to registration

  If you purchased a physical version of this product, your serial number is located on the inside of the box

  If you purchased an electronic version of this product, your serial number will be included in a confirmation email

  You can see a list of the products you’ve registered and their serial numbers anytime at uvi.net/my-products 

1. Login to your account on uvi.net/

2. Navigate to the ‘Product Registration’ page

3. Enter your details and click ‘Register’

 Upon completion a new license will be
 deposited in your iLok account

1 2 3 4Register Your Serial NumberStep 1
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1. Launch iLok License Manager

2. Login to your account

3. Click the ‘Available’ tab

4. Drag the license to your computer
 or an iLok dongle

5. Click ‘Ok’ to confirm the activation

 The process is complete, your  
 device is now authorized

  iLok License Manager is required for activation, download the newest version at ilok.com/ilm.html  

  Your license allows up to 3 concurrent activations on any combination of iLok dongles and computers

  Activations can be moved between devices at anytime

» To see how many authorizations you have left simply select the license and click ‘Show Details’

» To deactivate your license, right-click it and select ‘Deactivate’ — doing so will return your license to the ‘Available’ tab

1 2 3 4Activate Your LicenseStep 2
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2. Open UVI Workstation

3. Click the Settings page

4. Click the ‘Sound Banks’ tab

5. Click the ‘...’ button and select
 the folder where you’ve placed 
 your instruments

6. Restart UVI Workstation and 
  open the Browser

 Your instruments will be available  
 under the ‘Soundbanks’ tab

  UVI Instruments can be stored anywhere on your system

  Storing your instruments on a fast drive will improve performance

  Your instruments can be downloaded at any time from uvi.net/my-products 

1. Create a folder on your computer and place your UVI Instruments in it
 Once this is done we need to tell UVI Workstation where to find your instruments.

 We do this by creating a watch folder, follow the steps below to create your own:

Install Your InstrumentStep 3 1 2 3 4
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1. Open UVI Workstation

2. Click the Browser icon

3. Open the Sound Banks tab

4. Select a product, in this example 
 we’ll choose Vector Pro, then  
 select an instrument and patch 

 Double-click the patch to load it

5. The UI appears and you’re ready to jam!

1 2 3 4

  UVI Workstation is required to run UVI Instruments

  The newest version of UVI Workstation can be downloaded free at uvi.net/downloads 

  UVI Workstation can be run as a standalone program or as a virtual instrument from within your DAW of choice

Load Your InstrumentStep 4
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DS1 - Interface

2Amplitude

6Stereo

5Drive

3 Filter

4 Pitch

1 Mono / Poly

7 Bit Crusher

8 Effects

9 Modwheel

1  Mono/Poly
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel > Atk

Remaps Attack to Note Velocity

» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter

» VEL

Adjust the filter velocity sensitivity

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» ENV

Depth of the filter envelope

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento

» Time

Sets the glide time

5  Drive
» On/Off Switch

» Amount

Sets the drive amount

6  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [Width]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Width

Sets the stereo width (ALT mode)

» Tune

Detunes the unison layers (UNI mode)

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth
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DS1 - Preset List

Bass

Clav Dirty Bass

Crunch Power

Digital Fake

Duran X 2

Gritty Bass

Marcus Thumb

Muted B

My Double Bass

Pastorius Land

Synth Slap

Bells

Bell Air

Christmasonic

Church Bells

Mirah Bell

Orchestral Bells

Organ Bells

Ring My Bell

Sky Bells

Space Xylobell

Fretted

Dirty Clean

Double Guitar

Electric Steel

Garage Band

Harmodreams

Nylon Digital

Strato Crunch

The Fret and The Beauty

Keys

Digital Clav

DraculorgAn

Dream Electric

Fast Tremolo EP

FM Dyno

Hybrid Keys

Modern Doors

Mythical M Organ

Mythical M Piano

Nineties Stack

Perky Organ

Power Piano

SG Road

Soft Airy Church

SpaCelesta

Misc.

Electro Pop Corn

Ethnic Roll

Find the Mistake

FX Wheel Me 1

FX Wheel Me 2

Indian Steel Drums

Long Evolution

Mayhem of Loops

Mini Balafon

Multi Percs 1

Multi Percs 2

Multi Percs 3

One Thing

Perky Fluty

Peruvian Flavours

Run Mandolin

Short Wood

Tajma Hall

Orchestral

Baroque Harpsi

Digital Requiem

Ensemble Arco

Flute Ensemble

Full Horn Section

Large Choir 1

Large Choir 2

Open Orchestra

OrCELTICestra

Philharmonia

Pop Brass

So Emotional

Soft Buggle

Space Oboe 

TubulOrchestra

Pads

Bell Ominous

Chocolate Factory

Dream On

Hybrid Deep

Majesty

Moving Cycle

My Choirs

Nineties Pad

Paddy Fluty

Porta Chording

Porta Voices

Slow Stack

Space Requiem

Super Air

Vox Planet 1

Vox Planet 2

Wheel Me Tender

Zenithsphere

Synth Poly

Digital Fretted

DupStep Vox

Harsh Digital String

Pana Dubstep

Poly Brassy

Poly Vox

The Funky Poly

Synth Solo

Blow Lead

Echo Land

Funny Lead

Glassy Fluty

Phasio Lead

Solo Crunch

That Flute

The Funky Solo

Tight Synth

Typical House Sax

World Flute

Yon Soft Horns
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DS77 - Interface

2Amplitude

4Pitch

5Drive

1 Mono / Poly

3 Filter

7 Bit Crusher

8 Effects

9 ModWheel

6 Stereo

1  Mono/Poly
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel > Atk

Remaps Attack to Note Velocity

» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter

» VEL

Adjust the filter velocity sensitivity

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» ENV

Depth of the filter envelope

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento

» Time

Sets the glide time

5  Drive
» On/Off Switch

» Amount

Sets the drive amount

6  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [Width]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Width

Sets the stereo width (ALT mode)

» Tune

Detunes the unison layers (UNI mode)

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth
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DS77 - Preset List

Bass

Big Modwheel Me

ClaviBass

Da Synth

Double Bass

Electric Bass

FM Square Bass

Nasty Talk

Organic

Pure Nineties

Trash Bass

Bells

BeautHybrid

Digital Like

Dyno Bells

Easter Bells

Happy Rotter

Larsenic

Little Portam

MadBell Men

Massy Christmas

Musical Box

Round Golden

Sponsor Bells

Voicy Bell

Whole F Bell

Keys

Clavi Style

Digital Clav

Digital Organ

DS Pure Tines

Electronic Dyno

Extrem Dyno

FM Clavinet

Grand One

Hamm Organ

Large Electric

Large Spatial Road

My Dream

New Age EP

Phasynet

Pure Digital Keys

Real Clav

RnB Road

Soft Church

Space Toy Piano

Vocal EP

Yanni Keys

Leads

Dirty Brassy

Dirty Poly

FM Lead

Happy Whistle

Hybridation

Kitch Sax Lead

Milka Lead

Scream X

Soliclave

Synth SolHorn 

Misc.

Balaphonic

Disto Stack

Dreamology

Ethnic Pluck

FM Sarod

Fretted Synth

Fx Horlogery

Hesitation

Indian Flavour

Japamisen

Steel Electric Drum

Stratospheric

Vibraphone

Orchestral

French Ensemble

Full Ensemble

Glass Brass

Little Symphony

Simple Harp

Slowrchestra

Space Horns

Tutti Slowness

VibrOrchestra

Pads

Black Mont Blanc

DigOminous

Glossy Pad

Just Who Fly

Machine Strings

Magic Strings

Mellocoton

Motionesk

OMetal Pad

Pad on Five

Paradigm

Polaire

Slow Emotion

Smooth French

Solinox

SweePad

Ultra Dirty

Polysynth

Bronsky Poly

Cindy Bridge

Funky Mama

Ninth Dimension

Pluckmania 1

Pluckmania 2

Poly Keys

Raw Poly 1

Raw Poly 2

So Yummy Brass

Soft Digital Native

Synth Brass

Vocalized

Art of Voice

Choirizo

Ethereal Killer

Faith and Choir 1

Faith and Choir 2

Gladiators

Hummanoid

Hybrid Vocal

Lady GaVox

Massivocal

Planet Vox

Portachoir

Vocal Glass

Uboe

World Flute

Yon Soft Horns
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DS90S - Interface

2Amplitude

6Stereo

1Mode

5Drive

3 Filter

4 Pitch

7 Bit Crusher

8 Effects

9 ModWheel

1  Mode
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel > Atk

Remaps Attack to Note Velocity

» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter

» VEL

Adjust the filter velocity sensitivity

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» ENV

Depth of the filter envelope

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento

» Time

Sets the glide time

5  Drive
» On/Off Switch

» Amount

Sets the drive amount

6  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [Width]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Width

Sets the stereo width (ALT mode)

» Tune

Detunes the unison layers (UNI mode)

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth
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DS90S - Preset List

Bass

Analogish

Big Bass

Digital Harp JMJ

DigiTaurus

DS90s Wave Bass

Dual Slappy

FM Bass

Funk Analog B

Hard Drone

Huge Analog B

Hummer Digital

Hybrid Synth Bass

Imagination Bass

Mega Square

My Crazy B

Nineties Dubstep

Omni Bass

Pure Synth Bass

Reggaetonix

Road F Bass

Seq Glassy Bass

Space Slap

Tangerine Delay

Thumb Number

Ultra Bass

Vancouver Bass

Very Low Rkestra

Bells

Digital Box

Dream Bells

Fifth Dimension

Glass and Pad

Harpsybell

Iconic Bells

Kalimbell

Light Bells

Mad Chinese

Majestic Chimes

Mike New Field

My Little Bell

Nineties Hi Bells

One Digital Bell

Organic D90s Bells

Position Bell

Pro Ana Bells

Robert Bells

Soft Dirty Bells

Space Carillon

Sure Thing

Synth Analog Bell

That Bell

Unique Random

Keys

Dark Synth Piano

Digital Keys

Dual Clav

Full Tines 90s

Hard Dyno

Karoussel Mania

Keys Cassie

Little Piano

Magic Church

My Paroisse

Nineties Funk

OrganX

Percussiv Organ

Romantic Keys

Screamosphere

Soft Dirty Organ

Soft Keytar

Space Upright

Space Wurly

Synth Seq Keys

Ultra Soft Keys

Leads

BrassOloing

Curtis Pan Flute

Funky Five

Hard Panned Flute

House Lead

Hybrid Solo Synth

Jairo Lead

Latino Flute

Nine Lead

Pure Soft

Scream Solo

Shakuashi

Shop Lead

Shorty Slog

Solead Six

The Bee StooFly

Ultra Soft Solo Pad

Zebra Clinton

Pad - Choir

BBW Pad

Fair Synsations

Fairosphere

Flute Landscape

Glassy Glossy

La Chapelle

Mellow Choir

Moldavia

Monastere

Multi Flavored

My Padroisse

Ominalog

Pad in Box

Power Pad

Shaku Pad

Smooth and Dark

Space Choir

Sparkle D Pad

Synth Glass Vox

Tron Choir

Wheel to High

Zodiac Pad Bells

Polysynth

Hook Factory

Mallet Planet

Neat Analog

Obese Poly

Pol Crazy

Poly Metal

Power Synth

Scream Brass

Serious Synth

Short One

Skrillexed

Softy Poly

Standard Synth

Vangelis Feel

Strings-Orchestra

Digital Opening

Dynamic Ensemble

Ethereal Orchestra

Expressive Strings

Fastrings Brassy

Full Section

Harp and Orchesta

JarrOrchestra One

JarrOrchestra Two

Marcascendo

My White

Ominous Digital

Rugged Strings

Section French

Slow Lee Wood

Solo Detache

String Machine

Stringanalog

Tutti Orchestra

Sweeps

Chama Low

Flower Power

Hybrid Sweep

Naturalia

Steady Sweepy

Sweep on Wheel

Sweepy Lopez

Synth Brass

Classic Analog

Fat Brass

Funky Fresh

Iconic Brass

Matrix Brass

Mellow Brass

Number One

OB Phatty

Party Hook

Porta Brass

Power Brass

Pure Synth Brass

Soft Brass Ensemble

Solid Brass

Stab Digital

Tower Power

White Horns
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DSX - Interface

2Amplitude

6Stereo

5Drive

3 Filter

4 Pitch

1 Mode

7 Bit Crusher

8 Effects

9 ModWheel

1  Mode
Switch between mono and poly voicing

2  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel > Atk

Remaps Attack to Note Velocity

» Velocity

Adjust the amp velocity sensistivity

3  Filter
» ADSR

Typical envelope controls for the filter

» VEL

Adjust the filter velocity sensitivity

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» ENV

Depth of the filter envelope

» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

4  Pitch
» Depth

Sets the depth of portamento

» Time

Sets the glide time

5  Drive
» On/Off Switch

» Amount

Sets the drive amount

6  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [Width]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Width

Sets the stereo width (ALT mode)

» Tune

Detunes the unison layers (UNI mode)

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Effects
» Phaser

Adjust effect mix amount

» Delay

Adjust effect mix amount

» Reverb

Adjust effect mix amount

9  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth
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DSX - Preset List

Bass

Attackanalog

Digital Electric

Electric Pick

Mode Depeche Like

Move your B

Nineties Back

Pure Analog B

Slap Wha Wheel

So Analog

Square Bass

Transistoring

Bells - Mallet

Caribean Steel

Digital Sanzations

Digital SX Bells

Doors Bells

Little Celesta

M Balafon

Mallet Vibes

Mini Christmas

Smallet Box

Space Steel Drums

Synth Bells

Composite - Stack

Digital Native

Dream Piano Pad

Frets and Pads

Guitar Sine

Multi Layer Keys

Nineties Piano Strings

Space Guitar

Stackosphere

Strings and Horns

Electric Pianos

Composite Road

DSX Piano

DX Piano

Dynogital

Electric Synth Piano

Express Hybrid

FM Synsations

Hard Tines

Large Tines

Mixed Road Grand

Modeling TInes

Orlando Road

Tines after Time

Ultra Soft Road

Wurlysoniq

Leads

Analog Scream

Digital Square

High Solo

Hybrid Lead

MarimPan

Scie Musicale

Skrill Guitarex

Solo Synth Brass

Super Analog

Tutti Flutti

Misc. Keyboards

Baroque Harpsy

Clavi Planet

Concert Piano

Crunch Fast Organ

Digital Grand

Doors Maniac

Full Church

Full Drawbars

Grand One

Hybrid Piano

The Jaguar

Orchestral - Strings

Dark Orchestra

Dynamic Ensemble

Fair Orch Hit

Full Stacked

Large Strings

Marca Sean

Orchestral Timp

Power Strings

Soli Chamber

ZeBrass

Pad - Choir

Choirotron

Dark Portland

Deep Vox

Ever East

Hyper Majestic

Jack Mountain

MagiChorale

Mellow Cotton

Moving Pad

Padamento

Quaduo Bed

Space Choir 1

Space Choir 2

Very Fair X

War of Pads

Polysynth-Brass:

A Classic Brass

Digipolis

Eighties Pop Brass

Fat Synth Brass

Full Brass

Funky Digi Brass

Poly Snipper

That Polysynth

Uboe

World Flute

Yon Soft Horns
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  MIDI Learn

Most UVI Workstation parameters can be automated via. a convenient 

MIDI Learn. MIDI Learn allows you to bind a physical MIDI controller 

to specific parameters within UVI Workstation.

  Any FX tab parameter, Macro Knob or Slider in UVI instruments can 

use the MIDI Learn feature

  The MIDI controller type and the MIDI Channel assignment will be 

saved with the multi or with your song in the host sequencer 

  Automation is assigned per-part

To use MIDI Learn:

1. Right-click the parameter in UVI Workstation that you want to 

automate

2. After the MIDI Learn dialog appears, Trigger the desired MIDI input 

controller (knob, fader etc.)

To remove a MIDI controller assignment: 

Right-click the desired parameter and press “Delete”

  Arpeggiator

UVI Workstation comes equipped with a robust arpeggiator. To insert 

an arpeggiator in a part, you need to display the Single view in the 

UVI Workstation, then click on the note icon. The arpeggiator can 

be employed as a pattern gate, arpeggiator, or even an advanced 

rhythmic processor for your live MIDI performance or sequenced MIDI 

tracks. Arpeggiators can be inserted in an unlimited number of parts.

  Preset Stacking

Thanks to the simplicity of the UVI Workstation you can stack as 

many preset as you want by simply assign multiple part on the same 

MIDI channel.

  Scroll Wheel

All knobs can be adjusted with the scroll wheel on your mouse. 

When you double-click on any knob or slider, you can manually enter 

or type in the desired value.

  Split, Velocity & Key Switch

The Keyswitch settings allow you to load multiple presets into two 

or more parts and dynamically play and mute them from your MIDI 

controller using key switching, note range, velocity range or any 

combination of the three parameters. This powerful feature gives you 

a great deal of real-time control.

  Unlimited FX

UVI Workstation offers a wide variety of FX, or effect processors, 

to cover all your audio processing needs. The FX implementation is 

robust and includes the ability to insert unlimited FX slots in several 

stages of the signal flow.

  Click the “FX” tab to open the FX page on the Single view 

  In Multi view the FX section is always displayed

UVI Workstation: Tips + Tricks
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Links

UVI

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/ 

Download UVI Workstation and User Manuals . . . . . . . . . . . . . . . . . . uvi.net/downloads 

Your Registered Product Serial Numbers and Download Links.  .  .  .  .  .  .  .  .  uvi.net/my-products 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/faq 

Tutorial and Demo Videos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . youtube.com/

Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/contact-support 

iLok

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ 

iLok License Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ilm.html 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/supportfaq 
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